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The following Help Topics are available:

How To...
Look up something 
Find a sound 
Find a picture 
Find an animation 
Watch a video 

Commands
File 
Edit 
Search
Text
Window
Bookmark
Help

Toolbars 
Main Toolbar buttons and their functions
Other Toolbar buttons and their functions 

For Help on Help, Press F1



Main Toolbar buttons and their functions
These buttons appear on the Main Toolbar of the STME:

     Browse Titles   

     Word Index  

     Word Search  

     Knowledge Tree   

     Timeline   

     Map Index   

     Picture Index   

     Video Index   

     Animation Index   

     Sound Index   

     Help   

     Link to Selection   

     Next Link   

     Search for Selection   

     Add a Bookmark   

     Print   

     Save   



Other Toolbar buttons and their functions
These buttons appear on various toolbars throughout the STME:

Navigation buttons

     Move a level deeper in an index  

     Move a level higher in an index  

Audiovisual controls

     Play a sound/video/animation  

     Stop playing a sound/video/animation  

     Pause an video/animation   

     Move one frame forward in an animation   

     Move one frame backward in an animation   

Linking buttons

     Link to a map   

     Link to a picture   

     Link to a video   

     Link to an animation   

     Link to a sound   

     See cross-reference list   

Article view option buttons

     View table   

     View outline   

     View factbox   

     View caption   

     Move to the previous hit word   

     Move to the next hit word   



 Move a level deeper

This moves you a level deeper in an index, e.g., from topic to subtopic in the Knowledge 
Tree.

See also:
Other Toolbar buttons and their functions 



 Move to the previous hit word

This allows you to travel from one occurrence of your Search Term(s) to the previous 
one(s).

See also:
Other Toolbar buttons and their functions 



 Move to the next hit word

This allows you to travel from one occurrence of your Search Term(s) to the next one(s).

See also:
Other Toolbar buttons and their functions 



 Move a level higher

This moves you back up a level in an index, e.g., from subtopic to topic in the Knowledge
Tree.

See also:
Other Toolbar buttons and their functions 



 Pause an animation

Click this button to temporarily freeze animation playback.    Click play to resume.

See also:
Other Toolbar buttons and their functions 



 Move one frame forward

Click this button to move an animation forward one frame.
See also:
Other Toolbar buttons and their functions 



 Move one frame backward

Click this button to move an animation backward one frame.

See also:
Other Toolbar buttons and their functions 



 See cross-reference list

Use this toolbar button to see a list of articles cross-referenced from the current article.     
Scroll the list of cross-referenced articles to find the desired title.

Double-click an article title to view the article.    You may scroll through the article or, if 
you have accessed it through Word Search or Word Index, you may click the next hit 
word /previous hit word button to see the next/previous occurrence of your Search Term 
in the article.

See also:
Other Toolbar buttons and their functions 



 Play

Click the play button to start a video, animation, or a sound clip.

See also:
Other Toolbar buttons and their functions 



 Stop

Click the stop button to stop a video, animation, or a sound clip that is running.

See also:
Other Toolbar buttons and their functions 



 Link to a Map

Click the map button (if present) in the current article's toolbar to list the map(s) 
illustrating it.
Double-click a map title to view a map.

See also:
Other Toolbar buttons and their functions 



 Link to a Picture

Click the picture button (if present) in the current article's toolbar to list the picture(s) 
illustrating it.    Double-click a picture title to view a picture.    Click the caption button to 
read a picture's caption.

Some picture displays show a sound button.    Click it to access the audio controls for the 
sound associated with a picture.    Press the play button to play, press the stop button to 
stop.

See also:
Other Toolbar buttons and their functions 



 Link to an Animation

Click the animation button (if present) in the current article's toolbar to list the 
animation(s) illustrating it.    Double-click an animation title to select that animation.    
Click the play button to play it, click the stop button to stop it.

See also:
Other Toolbar buttons and their functions 





 Link to a Video

Click the video button (if present) in the current article's toolbar to list the video(s) 
illustrating it.    Double-click a video title to select that video.    Click the play button to 
play it, click the stop button to stop it.

See also:
Other Toolbar buttons and their functions 



 Link to a Sound

Click the sound button (if present) in the current article's toolbar to list the sound(s) 
associated with it.      Double-click a sound title to select that sound.      Click the play 
button to play it, click the stop button to stop it.

See also:
Other Toolbar buttons and their functions 



 View Table

Many articles in the STME list additional information in tabular form.

When you're looking at an article, this button will appear on the article's toolbar if there 
is one or more tables associated with the article.    Click it to list the table(s) associated 
with the article.    Double-click a table's title to view it.

When viewing the table, use the scroll bars to move through it.

See also:
Other Toolbar buttons and their functions 



 View Outline

Many of the longer articles in the STME have Outlines which make it easier to find the 
information you desire.    Click the Outline button from an open article to access the 
Outline.    Double-click the desired topic to move to that point in the article.

See also:
Other Toolbar buttons and their functions 



 View Caption

Use this toolbar button when you're looking at a picture or a video to see the caption that
describes it.

See also:
Other Toolbar buttons and their functions 



 View Factbox

Factboxes are lists of important, frequently-cited statistics.    They are found in the STME's
articles on continents, countries, U.S. presidents, U.S. states, and Canadian provinces.

When you're looking at an article, this button will be present in the article's toolbar if 
there's a Factbox associated with the article.    Click it to move to the article's Factbox.

When viewing the Factbox, use the scroll bars to move through it.

See also:
Other Toolbar buttons and their functions 



File Menu
The following commands are available from the File menu:

Save 
Close 
Printer Setup 
Print 
Preferences 
Exit 



Edit Menu
The following commands are available from the Edit menu:

Undo 
Cut 
Copy 
Paste 



Search Menu
The following commands are available from the Search menu:

Browse Titles 
Word Search
Word Index 
KnowledgeTree 
Timeline 
Multimedia 
Find 
Search for Selection 
Link to Selection 
Next Link 



Text Menu
The following command is available from the Text menu:

Font 



Window Menu
The following commands are available from the Window menu:

Toolbar 
Status 
Cascade 
Tile 
Arrange Icons 
Close All 



Bookmark Menu
The following commands are available from the Bookmark menu:

Bookmark List 
Add 
Delete 



Help Menu
The following commands are available from the Help menu:

Contents 
About 



Save (File menu)

You may save STME text in ASCII format to use in a word-processing program, or you 
may save it in a print-to-disk format.    The dialog box allows you to save the complete 
article (default), a highlighted selection, or a window of text.

Shortcut:  on the Main Toolbar



Close (File menu)

Use this to close the currently active window.



Printer Setup (File menu)

Use this to configure Windows and the way it deals with your printer.    The dialog box 
allows you to specify which printer to use, printing orientation (portrait/landscape), and 
paper size.



Print (File menu)

Use this to print the currently selected text.    The dialog box allows you to select the 
complete article, a highlighted portion, or a range of pages.    It also allows you to specify
print quality or to print to a file.

Shortcut:  on the Main Toolbar



Preferences (File menu)

Select Preferences to customize your STME by changing its default settings.    You can 
change the following settings from this window:

Default search settings
Use this to specify whether the results of a search are to be sorted alphabetically (by 
article title), or by the frequency of occurrence of the Search Term(s) (e.g., an article with
10 occurrences of a Search Term is listed before an article with only 3 occurrences).

You can also change the "number of words apart" criterion in a search with multiple 
Search Terms; see Search Options for more information.

Animation speed
Depending on your computer's speed and your own taste, you may want to change the 
speed at which animations are played.      Use this option to change the playback speed.

Display title animation at startup
If you don't want to see the startup sequence (the collection of pictures), remove the "X" 
from this option.

Display Status Bar at startup
If you want the status bar to be active when you start the STME, mark this checkbox.    
See also: Status (Window Menu).

Display Videos in Full Screen
If you choose this option, the STME's videos will appear in "full screen" mode, that is, the 
normal Windows environment (the STME window, the Program Manager window, any 
other open windows, etc.) will go away, and the video appears in its place.    A video 
played in this way will be "bigger" (i.e., take up more space on your computer screen) 
than its normal Windows counterpart; this enlargement may be preferable to you 
because it makes videos appear brighter; however, videos also appear to be more grainy
in full screen mode.

Display Toolbar at startup
This lets you customize the appearance of the Main Toolbar when you start the STME.    
For more information, see Toolbar (Window Menu).



Exit (File menu)

Use this command to end your STME session.



Undo (Edit menu)

Use this to Undo your previous action.



Cut (Edit menu)

Use this to cut the currently selected text from a window.    You may use this text in other 
Windows applications (e.g., word processing programs).



Copy (Edit menu)

Use this to copy the currently selected text from a window.    You may use this text in 
other Windows applications (e.g., word processing programs).



Paste (Edit menu)

Use this to paste text (from your most recent Cut or Copy) to the cursor location in the 
current window.    You may use this text in other Windows applications (e.g., word 
processing programs).



Browse Titles (Search menu)

This gives you an article index containing an alphabetical list of the 33,000+ articles in 
the STME.

Finding an Article
Type the first few letters of a subject and select Find to move the cursor to that point in 
the Article Index.    Select your desired topic.    Double-click to open the article.

Shortcut:  on the Main Toolbar



Word Search (Search menu)

Word Search lets you search for references to a word or set of words in the STME.

Simple Word Search
The simplest way to use Word Search is to type in a single word.    (Note: certain words, 
such as "and," are excluded from this feature because they occur too frequently in the 
STME to provide meaningful Word Search results.)    Click the Search button and the STME
will look for the word you've typed.    The STME will list all of the articles that contain the 
word.

Double-click an article title to see the article; the cursor will move to the first occurrence 
of the word in it.    Click the forward/backward buttons to see subsequent/previous 
occurrences of the word.

Complex Word Search
You can do more sophisticated word searches by using tools and options provided in the 
Word Search dialog box.    These help you limit or expand your search, as you see fit.

Operators and Wild Cards 
These let you look for variations and combinations of words in a search.

Search options 
These are tools provided by Word Search that let you specify where and how 
to look for a word or group of words.

Other Word Search controls
There are two other special controls in the Word Search dialog box:

Paste
This button lets you paste the contents of the Windows clipboard into the 
current Search Term field.    This is especially useful if you've copied a word 
from another article, or from another Windows application (such as a word 
processor).

Reset 
This button resets the search, erasing all Search Terms and resetting any 
operators or other options you may have changed.

Shortcut:  on the Main Toolbar



Word Index (Search menu)

The Word Index lists, in alphabetical order, each word that appears in the STME.

Click this button to open the Word Index.    Type in a word.    As you type, a Find box will 
appear.    Click Find after you type in a word.    The cursor will move to that word in the 
Word Index.    Double-click to see a list of articles containing the word, sorted by number 
of occurrences.

Shortcut:  on the Main Toolbar



Knowledge Tree (Search menu)

KnowledgeTree lets you explore the STME by subject, gradually refining your search from 
a broad topic to subtopics to individual articles on your subject.

Using Knowledge Tree
A plus sign next to a topic name indicates that a topic must be explored further to reach 
individual articles (e.g., + The Arts).

A minus sign next to a topic name indicates the path your search has taken.

Select and double-click a topic without a plus or minus sign to see a list of articles related
to that subtopic.

Shortcut:  on the Main Toolbar



Timeline (Search menu)

The Timeline is a chronological list of more than 5,000 historical events.      It allows you 
to explore the STME with time as a frame of reference.

Using the Timeline
Type a year and AD or BC to look at events for a certain year.    You may also scroll 
through the list.    Double-click a Timeline event to see a list of articles related to the 
event.

Shortcut:  on the Main Toolbar



Multimedia (Search menu)

Use this to gain access to the multimedia features of the STME.    There are four choices 
available from this menu item:

Pictures 
This gives you an index of all the pictures in the STME.

Shortcut:  on the Main Toolbar.

Maps 
This gives you an index of all the maps in the STME.

Shortcut:  on the Main Toolbar.

Videos 
This gives you an index of all the videos in the STME.

Shortcut:  on the Main Toolbar.

Animations 
This gives you an index of all the animations in the STME.

Shortcut:  on the Main Toolbar.

Sounds 
This gives you an index of all the sounds in the STME.

Shortcut:  on the Main Toolbar.

Moving through an Index
Each index is structured as an outline, and each section of the outline may be expanded 
and collapsed.    Click the plus sign to expand a category.    Click the minus sign to 
collapse it.



Find (Search menu)

Find allows you to look for the next occurrence of any word in an article or picture 
caption.    After you select Find, type the word you want to locate in the Find dialog box 
and click Find. 



Next Link (Search menu)

Next Link helps you find the next Link Word (an article title set in ALL CAPS) from within 
an article. 

From any word in an open article, select Next Link to move the cursor to the next cross-
referenced article title.    You can then use the Link to Selection command to search for 
that title in the Title List.

Shortcut:  on the Main Toolbar



Link to Selection (Search menu)

Link to Selection allows you to search the Title List for a Link Word (an article title set in 
ALL CAPS within an article).

Move the cursor to the first letter of a Link Word and select Link to Selection.    The STME 
will open the Title Index and automatically select the Link Word.    Double-click the title 
(or press Enter) to look at that article.

Shortcut:  on the Main Toolbar



Search for Selection (Search menu)

Search for Selection allows you to select (highlight) words or strings of words in open 
articles and find other articles in which the words appear.    For example, if you select the 
word "physics" in an article, the STME will create a list of all articles in which "physics" 
appears.

Shortcut:  on the Main Toolbar



Font (Text menu)

This feature allows you to customize the appearance (on screen) of the text elements of 
the STME.    The Font dialog box allows you to specify base font, font style, and font size.



Toolbar (Window menu)

This feature allows you to customize the appearance of the Main Toolbar.    You may 
choose one of the following:

Off
This conceals the Main Toolbar, giving you more space in the Main STME window.

Top
This makes the Main Toolbar appear as a row of buttons beneath the Menu Bar.

Float
This turns the Main Toolbar into a movable window, which you can "float" among other 
windows you have opened in the STME.    Use Float to gain space in the Main STME 
Window    without sacrificing the convenience of the Toolbar.    (Note: Other Windows 
applications call this a "tool palette.")

See also:
Main Toolbar buttons and their functions 
Other Toolbar buttons and their functions 



Status (Window menu)

This feature allows you to toggle between displaying and concealing the Status bar, 
which provides information on the status of actions taken in the STME.    Concealing it 
gives you more space in the main STME window.



Cascade (Window menu)

Cascade arranges opened windows on top of each other, like a set of index cards.    It 
puts the most recently opened window on top, and displays each window's title, for easy 
movement between windows.



Tile (Window menu)

Tile arranges opened windows next to each other, for easy comparison of contents.



Arrange Icons (Window menu)

Use this command to arrange the icons (representing minimized windows) in an orderly 
fashion in the main STME window.



Close All (Window menu)

Use this command to close all of the currently open windows, without shutting down the 
STME. 



Bookmark List (Bookmark menu)

Bookmark lets you create a list of STME articles of interest for future reference.

To open a bookmarked article
Double-click the desired Bookmark name to access the bookmarked article.

To delete a Bookmark
Choose Delete from the Bookmark menu to delete the currently selected Bookmark.



Add a Bookmark (Bookmark menu)

Use this command to save your place in an STME article.    You can retrieve it later by 
using the Bookmark List command.

When you select Add a Bookmark, you'll see a box with a Bookmark Title. The default is 
the article's title, but you may type in a more descriptive name. Click OK to store the 
Bookmark.

Shortcut:  on the Main Toolbar



Delete a Bookmark (Bookmark menu)

Use this command while looking at the Bookmark List to delete a Bookmark.    When you 
choose it, the currently selected Bookmark is deleted.



Help Contents (Help menu)

The Help Contents lists, in outline form, all of the Help topics available in the STME.

For help on using Help, press the F1 key.

Shortcut:  on the Main Toolbar



About (Help menu)

This gives details about the STME such as the version number and copyright information.



Map Index (Search menu, Multimedia choice)

The Map Index lists all of the maps in the STME, grouped by geographical location.

Viewing maps using the Map Index
Double-click the name of a region to list maps for that region.    Double-click the map's 
title to view it.    You may also see a list of articles cross referenced from the current map 
by clicking the cross-reference button in the Map Index window's toolbar.

From each map you may see a list of cross-referenced articles by clicking the cross-
reference button in the map window's toolbar.

Shortcut:  on the Main Toolbar.



Picture Index (Search menu, Multimedia choice)

The Picture Index lists all of the pictures in the STME, grouped by subject.

Viewing pictures using the Picture Index
Pictures are indexed in outline form.    A plus sign (+) before a title indicates that you are 
at a topic within the Index, and that you must expand the index to reach picture titles.    A
minus sign (-) indicates your path so far.      Picture titles are indicated by the absence of a
plus or minus sign.      (Many pictures are linked to sounds; this is indicated by an asterisk 
(*) after the picture title.)

You can look at a picture by double-clicking its title.    You can look at a list of articles 
cross referenced to the selected picture by clicking the cross-reference button in the 
Picture Index window's toolbar.

Each picture's window has its own toolbar, containing one or more of these buttons:

     View caption   

     See cross-reference list   

     Link to a sound   

Shortcut:  on the Main Toolbar.



Animation Index (Search menu, Multimedia choice)

The Animation Index lists all of the animations in the STME, grouped by subject.

Viewing Animations using the Animation Index
Click the animation button to list animation categories.    Double-click a category name to
list animation titles for that category.

(Animation titles have no preceding symbol; a plus sign indicates a category or sub-
category of animations.)

Click the play button to view an animation.    Click the stop button to stop it.

When an animation title is selected, click the cross-reference button on the Animation 
Index window's toolbar to view a list of articles related to that animation.

Shortcut:  on the Main Toolbar.



Video Index (Search menu, Multimedia choice)

The Video Index lists all of the videos in the STME, grouped by subject.

Using the Video Index
After choosing this option (either through the Search menu under Multimedia or through 
the Main Toolbar's Video Index button), you'll see a list of video categories.    Double-click 
a category name to list video titles for that category.

(Video titles have no preceding symbol; a plus sign indicates a category or sub-category 
of video.)

Click the play button to view a video.    Click the stop button to stop it.

When an video title is selected, click the cross-reference button on the Video Index 
window's toolbar to view a list of articles related to that video.

Shortcut:  on the Main Toolbar.



Sound Index (Search menu, Multimedia choice)

The Sound Index lists all of the sound clips in the STME, grouped by subject.

Listening to sounds using the Sound Index
Double-click a category to list sound clip titles.    Double-click the title of a sound clip to 
display the audio control panel.    Click the play button to start a sound clip; click the stop
button to stop it.

Click the cross-reference button to list the titles of articles related to a sound clip.

Shortcut:  on the Main Toolbar.



What's a Toolbar?
A toolbar is a set of buttons, usually located beneath the title bar of a window, which 
gives you quick access to frequently used commands in the STME.

Using a Toolbar
Click a Toolbar button to call up the STME feature it represents.



What's the STME?
The STME, which you are currently using, is the Software Toolworks Multimedia 
Encyclopedia.    The STME features the complete text of Grolier's Academic American 
Encyclopedia, plus pictures, maps, sounds, and animations.



What's a default?
In a computer program, a default is the way settings and options are defined by the 
program before a user changes or redefines them.    In other words, a default is an action 
or setting done without user intervention, something done "by default."    Many 
programs, such as the STME, allow you to change some default values to suit your own 
needs and tastes.



What's a hit word?
A hit word indicates a match between a word you're searching for and a word in the 
STME.    It's often convenient, especially in a long article, to move forward and backward 
among hit words to find the information you're looking for.



What's ASCII?
ASCII (pronounced /as' kee/) is an acronym for American Standard Code for Information 
Interchange.    Many applications (including the STME and most word processors) use this
term to refer to unformatted, "raw" text.    Documents "saved in ASCII" contain no special
formatting commands or codes, and therefore are easily recognized and used by a 
variety of applications.



Search Options (Word Search)

The Word Search has a few options to let you specify where and how to look for 
occurrences of your search terms.

Word Relationship
Word Relationship lets you fine-tune your search by specifying certain criteria for a 
successful search.

Same Paragraph
When this is chosen, the search will require that all the terms you've specified 
be in the same paragraph.    This criterion is chosen by default.

Words Apart
When chosen, this lets you specify how close multiple Search Terms must be 
to each other to show up in your Word Search.

Exact Order
Use this checkbox to find a precise phrase (i.e., search for the words you've 
specified in the same order you've typed them).

Search in
This lets you fine-tune your search by specifying which parts of STME entries to search.



Operators and Wild Cards (Word Search option)

Word Search lets you use operators and wild cards to limit or broaden your search.    
Particularly helpful are the AND, OR, and NOT operators, which can be used to set up 
criteria among multiple Search Terms.    Wild cards are helpful in finding words related to 
your Search Term, or if you're not sure of the spelling of a particular word.

AND
This lets you search for two or more words in a single article (each Search Term must 
appear in the article at least once).
How to do it: Type the words on separate lines and choose AND in the drop-down menu 
next to the words (this is chosen by default)

OR
This lets you search for two or more words in a single article (at least one Search Term 
must appear in the article).
How to do it: Type multiple words on one line, separated by commas.

NOT
This lets you search for the presence of a word or combination of words in the absence of
another or others.
How to do it: Type the words on separate lines and choose NOT in the drop-down menu 
next to the word(s) you want exclude from the search.

Wild Card (single character)
This will find all instances where your Search Term plus any single letter forms a word 
(e.g., QUOT? will match "quota" and "quote").
How to do it: Type a question mark ("?") at any location in the Search Term.

Wild Card (multiple characters)
This will find all instances where your Search Term plus any number of letters forms a 
word (e.g., QUOT* will match "quota,"    "quotation," "quoted," "quotes," etc.).
How to do it: Type an asterisk ("*") at the end of your Search Term.



How to Look Up Something in the STME

Here are three ways to Look Up Something in the STME:

Pretty sure you know where your subject would be covered?
Click the Browse Titles button on the Main Toolbar and type the name of a person (last 
name first!), place, or thing.    The STME will bring you to that point in its alphabetical 
Article Index. Double-click a title to read an article.    You can scroll through the Article 
Index to look at other articles.

Not sure of what article would cover your subject?
You may want to do a Word Search.    Click the Word Search button on the Main Toolbar, 
type in a word, and click search.    The STME will prepare a list of articles that contain the 
word you typed.    Scroll to and double-click an article title, and the STME will bring you to
the part of the article where your subject first appears.

Maybe you're not exactly sure what you're interested in researching.
You may want to use the Knowledge Tree.    Click the Knowledge Tree button on the Main 
Toolbar to see the 6 main "branches" of knowledge in the STME.    Double-click to go 
further and further down a "branch" of knowledge until you see an article of interest.    
Double-click an article title to read that article.



How to Find a Sound

Click the Sound Index button on the Main Toolbar to list the 5 types of sounds featured in 
the STME (animal, bird, and musical-instrument sounds, and excerpts of musical works 
and historical speeches).    Double-click one of the types to list individual sounds.    
Double-click a sound title and press play to hear that sound.



How to Find a Picture

The STME has over 3,000 pictures, indexed by subject.    Click the Picture Index button on
the Main Toolbar to see the list of subjects.    Keep double-clicking index entries until you 
see the titles of individual pictures.    Double-click a picture title to see it; click the caption
button to read the picture's caption.



How to Find an Animation

Click the Animation Index button on the Main Toolbar to list the types of animations 
featured in the STME (The Human Body, Machines and Mechanical Processes, and The 
World).    Double-click one of these types to list individual animations.    Double-click an 
animation title and press play to see that animation.



How to Watch a Video

Click the Video Index button on the Main Toolbar to list the types of videos featured in 
the STME (Animal Life, Historical Events and Personalities, Plants and Fungi, etc.).    
Double-click one of these types to list individual videos.    Double-click a video title and 
press play to see it.


